o~

£ CYPRESS

Embedded in Tomorrow”

3
!

W),

CY3677

Evaluation Kit User Guide

Doc. No. 002-12185 Rev. *D

Cypress Semiconductor

198 Champion Court

San Jose, CA95134-1709
Phone (USA): 800.858.1810
Phone (Intnl): +1.408.943.2600

WWW.Cypress.com


http://www.cypress.com/

CYPRESS
Embedded in fomorrow Copyrights

Copyrights

© Cypress Semiconductor Corporation, 2016-2017. This document is the property of Cypress Semiconductor Corporation
and its subsidiaries, including Spansion LLC (“Cypress”). This document, including any software or firmware included or
referenced in this document (“Software”), is owned by Cypress under the intellectual property laws and treaties of the United
States and other countries worldwide. Cypress reserves all rights under such laws and treaties and does not, except as
specifically stated in this paragraph, grant any license under its patents, copyrights, trademarks, or other intellectual property
rights. If the Software is not accompanied by a license agreement and you do not otherwise have a written agreement with
Cypress governing the use of the Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable
license (without the right to sublicense) (1) under its copyright rights in the Software (a) for Software provided in source code
form, to modify and reproduce the Software solely for use with Cypress hardware products, only internally within your
organization, and (b) to distribute the Software in binary code form externally to end users (either directly or indirectly through
resellers and distributors), solely for use on Cypress hardware product units, and (2) under those claims of Cypress’s patents
that are infringed by the Software (as provided by Cypress, unmodified) to make, use, distribute, and import the Software
solely for use with Cypress hardware products. Any other use, reproduction, modification, translation, or compilation of the
Software is prohibited.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, WITH REGARD TO THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. To the extent permitted by applicable law, Cypress reserves the right to make changes to this document without
further notice. Cypress does not assume any liability arising out of the application or use of any product or circuit described
in this document. Any information provided in this document, including any sample design information or programming code,
is provided only for reference purposes. It is the responsibility of the user of this document to properly design, program, and
test the functionality and safety of any application made of this information and any resulting product. Cypress products are
not designed, intended, or authorized for use as critical components in systems designed or intended for the operation of
weapons, weapons systems, nuclear installations, life-support devices or systems, other medical devices or systems
(including resuscitation equipment and surgical implants), pollution control or hazardous substances management, or other
uses where the failure of the device or system could cause personal injury, death, or property damage (“‘Unintended Uses”).
A critical component is any component of a device or system whose failure to perform can be reasonably expected to cause
the failure of the device or system, or to affect its safety or effectiveness. Cypress is not liable, in whole or in part, and you
shall and hereby do release Cypress from any claim, damage, or other liability arising from or related to all Unintended Uses
of Cypress products. You shall indemnify and hold Cypress harmless from and against all claims, costs, damages, and other
liabilities, including claims for personal injury or death, arising from or related to any Unintended Uses of Cypress products.

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB,
F-RAM, and Traveo are trademarks or registered trademarks of Cypress in the United States and other countries. For a
more complete list of Cypress trademarks, visit cypress.com. Other names and brands may be claimed as property of their
respective owners.
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The CY3677 Evaluation Kit is intended for use as an evaluation platform for hardware or software in a laboratory environment.
The board is an open system design, which does not include a shielded enclosure, so the board may cause interference to
other electrical or electronic devices in close proximity. In a domestic environment, this product may cause radio interference.
In such cases, the user may be required to take adequate preventive measures. Also, this board should not be used near any
medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default may affect its
performance and cause interference with other apparatus in the immediate vicinity. If such interference is detected, suitable
mitigating measures should be taken.

The CY3677 Evaluation Kit contains electrostatic discharge (ESD)-sensitive devices. Electrostatic
charges readily accumulate on the human body and any equipment, and can discharge without detection.
Permanent damage may occur on devices subjected to high-energy discharges. Proper ESD precautions
\ are recommended to avoid performance degradation or loss of functionality. Store unused CY3677
m Evaluation Kit boards in the protective shipping package.

General Safety Instructions
ESD Protection

ESD can damage boards and associated components. Cypress recommends that the user perform procedures only at an
ESD workstation. If an ESD workstation is not available, use appropriate ESD protection by wearing an antistatic wrist strap
attached to the chassis ground (any unpainted metal surface) on the board when handling parts.

Handling Boards

The CY3677 Evaluation Kit is sensitive to ESD. Hold the board only by its edges. After removing the board from its box, place
it on a grounded, static-free surface. Use a conductive foam pad if available. Do not slide the board over any surface.

Certification Disclaimer

This kit is intended for demonstration, evaluation, or development purposes only and is not considered by Cypress
Semiconductor to be a finished end-product fit for general consumer use. It generates and can radiate radio frequency energy
and has not been specifically tested for CE certification compliance. Operation of this equipment in other environments may
cause interference with radio communications, in which case users at their own expense will be required to take whatever
measures may be required to correct this interference.
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Thank you for your interest in the CY3677 Evaluation Kit (EVK). The CY3677 EVK is designed to enable you to evaluate the
programmable clock device CY29430, the latest addition to the Cypress timing product portfolio. The clock device CY29430
is a high-performance programmable oscillator with one fractional PLL that generates any frequency up to 2.1 GHz with jitter
as low as 110 fs. The device offers one differential output and one single-ended output. The device can be configured to
generate either a single-ended output or a differential output but not both simultaneously. The device comes in a 16-pin QFN
package for industrial applications. The differential I/O standards supported are LVDS, LVPECL, High-Speed Current Steering
Logic (HCSL), and Current Mode Logic (CML). The single-ended signal supported is LVCMOS. The device also supports
features such as a Voltage-Controlled Crystal Oscillator (VCXO), and provides the user with an I12C programming interface.
The device supports four frequency profiles, which can be switched dynamically using external Frequency Select (FSO and
FS1) signals. There are two jumpers provided on the EVK to perform frequency selection on the board.

The CY3677 EVK allows you to evaluate output clock signals by making required on-board termination settings.

The CY3677 EVK is available through the Cypress Online Store or through our distributors.
1.1 CY3677 EVK Contents
The CY3677 EVK includes the following:

e CY3677 Evaluation Board
e USB Standard-A to Mini-B cable
e  Quick Start Guide
Figure 1-1. CY3677 Kit Contents

QUICK START GUIDE

LUATION KIT
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Inspect the contents of the kit. If you find any part missing, contact your nearest Cypress sales office for assistance:
WWW.Cypress.com/support.

1.2 Getting Started

To learn the solution quickly and apply it to your design, refer to the CY3677 Quick Start Guide inside the kit box or in the
installation directory. The default location for the kit documents is:

<Install Directory>\CY3677 Evaluation Kit\<version>\Documentation

This guide will help you get acquainted with the CY3677 EVK:

The Software Installation chapter describes the installation of the kit software.

The Kit Operation chapter describes the major features of the CY3677 Evaluation Kit.

The Hardware chapter describes the hardware content of the CY3677 Evaluation Kit and the hardware operation.

The Example Projects chapter describes the multiple projects that will help you understand how to evaluate different
supported output standards on this kit.

The Appendix captures DC/AC Measurements of Clock Outputs, Schematics, Fab Drawing, and the bill of materials (BOM).

1.3 Additional Learning Resources

Visit www.cypress.com/CY3677 and www.cypress.com/HPO for additional learning resources including datasheets and
application notes.

1.4 Technical Support

For assistance, go to www.cypress.com/support, or contact our customer support at +1(800) 541-4736 Ext. 2 (in the
USA), or +1 (408) 943-2600 Ext. 2 (International).

CY3677 Evaluation Kit User Guide, Doc. No. 002-12185 Rev. *D 7
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1.5 Document Conventions
Table 1-1. Document Conventions for Guides
Convention Usage
Courier New Displays file locations, user entered text, and source code:
C:\ ...cd\icc\
Italics Displays file names and reference documentation.
[Bracketed, Bold] Displays keyboard commands in procedures:
[Enter] or [CtrI] [C]
File > Open Represents menu paths:
File > Open > New Project
Bold Displays commands, menu paths and icon names in procedures:
Click the File icon and then click Open.
Times New Roman Displays an equation:
2+2=4
Text in gray boxes Describes Cautions or unique functionality of the product.
1.6 Acronyms
Table 1-2. List of Acronyms used in this Document
Acronym Definition
BOM Bill of Materials
CML Current Mode Logic
DNP, DNM Do Not Populate, Do Not Mount
FS Frequency Select
HCSL High-Speed Current Steering Logic
12C Inter-Integrated Circuit
JEDEC Joint Electron Device Engineering Council
LDO Low-Dropout
LVCMOS Low Voltage Complementary Metal Oxide Semiconductor
LVPECL Low Voltage Positive Emitter Coupled Logic
LVPECL2 Low Voltage Positive Emitter Coupled Logic with zero Common-mode current
LVDS Low Voltage Differential Signaling
OE Output Enable
oT3 Third Overtone Crystal
SMA Subminiature Version A
VCXO Voltage-Controlled Crystal Oscillator
TCXO Temperature Compensated Crystal Oscillator
OTP One-Time Programmable
CY3677 Evaluation Kit User Guide, Doc. No. 002-12185 Rev. *D 8
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This chapter describes the steps to install the software tools and packages on a PC for using the CY3677 Evaluation Kit.

2.1 Before You Begin

All Cypress software installations require administrator privileges. Ensure that you have the required privileges on the system
for successful installation. Before you install the kit software, close any other Cypress software that is currently running.

2.2 Install Software

Follow these steps to install the CY3677 Evaluation Kit software:

1. Download the CY3677 Evaluation Kit software from www.cypress.com/CY3677. The software is available in the following
formats:

a. CY3677 Evaluation Kit Complete Setup: This installation package contains the files related to the CY3677
Evaluation Kit. However, it does not include the Windows Installer or Microsoft .NET Framework packages. If these
packages are not available on your computer, the installer directs you to download and install them from the Internet.

b. CY3677 Evaluation Kit Only: This executable file installs only the CY3677 EVK contents, which include example
projects, hardware files, and user documents. This package can be used if all the software prerequisites are installed
on your PC.

c. CY3677 Evaluation Kit ISO: This file is a complete package, stored in a CD/DVD-ROM image format that you can
use to create a CD/DVD or extract using an ISO extraction program such as WinZip or WinRAR. The file can also
be mounted similar to a virtual CD/DVD using virtual drive programs such as Virtual CloneDrive and MagiclSO. This
file includes all the required software, utilities, drivers, hardware files, and user documents.

2. If you have downloaded the ISO file, mount it on a virtual drive. If you do not have a virtual drive to mount, extract the
ISO contents using the appropriate 1SO extractor (such as MagiclSO or PowerlSO). Double-click cyautorun.exe in the
root directory of the extracted content or the mounted ISO if the “Autorun from CD/DVD” option is not enabled on the PC.
The installation window will appear automatically.

Note: If you are using the “Kit Complete Setup” or “Kit Only” file, then go to step 4 for installation.
3. Click Install CY3677 EVK to start the installation as shown in Figure 2-1.

CY3677 Evaluation Kit User Guide, Doc. No. 002-12185 Rev. *D 9
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Figure 2-1. Installer Screen
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CY3677 EVK

Install CY3677 EVK
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© 2016 Cypress Semiconductor Corporation. Al rights reserved

Click Change... if you want to install the CY3677 EVK in a location other than the default, and then click Next as shown
in Figure 2-2.

Note: When you click Next, the CY3677 EVK installer automatically installs the required software, if it is not present on
your computer. The pre-requisites are ClockWizard 2.1 and PSoC Programmer 3.25.0 or later.

Figure 2-2. InstallShield Wizard

-

CY3677 Evaluation Kit - InstallShield Wizard

Welcome to the InstallShield Wizard for CY 3677
Evaluation Kit

The InztallShield wizard will install Ty 3677 Evaluation Kit n
on your computer. To continue, click Mest.

Select folder where setup will install files.

G Imetall Cv'367T Evaluation Kit to:
C:h ACypress

< Back [ Mext » J[ Cancel
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Select the Installation Type (see Figure 2-3). The drop-down menu contains three options: Typical (installs all the
required features), Custom (lets you choose the features to be installed), and Complete (installs all the contents). Click
Next after you select the Installation Type.

o

Note: It is recommended that you choose the Typical Installation Type.

Figure 2-3. Product Installation Overview

r Ny
& Cylnstaller for CY3677 Evaluation Kit m

Product Installation Overview
Choose the install type that best suits your needs

Choose the type of installation

Product:
CY3677 Evaluation Kit

Installztion Type:

Typical v

Installs the most common features of
CY3677 Evaluation Kit.

Next > ][ Eaocel

6. Read and accept the End-User License Agreement, and then click Next.

When the installation begins, a list of packages appears on the Installation page. A green check mark appears next to
each package after successful installation.

7. Enter your contact information or select the Continue Without Contact Information check box.
8. Click Finish to complete the CY3677 Evaluation Kit installation.

After the installation is complete, the kit contents are available at:

<Install Directory>\CY3677 Evaluation Kit\<version>.

Default location:

Windows 7 (64-bit): c:\Program Files (x86)\Cypress\CY3677 Evaluation Kit

Windows 7 (32-bit): c:\Program Files\Cypress\CY3677 Evaluation Kit

CY3677 Evaluation Kit User Guide, Doc. No. 002-12185 Rev. *D 11
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2.3 Install Hardware

No additional hardware installation is required for this kit.

2.4 Uninstall Software

You can uninstall the software using one of the following methods:

e Goto Start > All Programs > Cypress > Cypress Update Manager > Cypress Update Manager, and select the
specific software package. Click the Uninstall button.

e Goto Start > Control Panel > Programs and Features, and select the specific software package. Click the
Uninstall/Change button.

CY3677 Evaluation Kit User Guide, Doc. No. 002-12185 Rev. *D 12
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The CY3677 EVK can be used to evaluate the CY29430, a high performance programmable oscillator. Connect the CY3677
kit through USB to a PC running Cypress’s ClockWizard 2.1 software. The clock device CY29430 can be configured and
programmed to generate frequencies with best-in-class performance.

3.1 Theory of Operation

The CY3677 EVK offers one differential clock output and one single-ended clock output (only one operates at a time) for
evaluation. The CY29430 device uses an on-board crystal or Temperature Compensated Crystal Oscillator (TCXO) reference
input.

The kit is capable of generating fixed 3.3 V, 2.5V, and 1.8 V voltages from a 5-V USB port. The on-board PSoC 5LP (U7)
performs the USB-to-I>C conversion. There is one power LED (LED2) driven from the on-board LDO supply and one status
LED (LED1) controlled by PSoC 5LP. The output of LDO regulator (U8) is configurable (3.3 V, 2.5 V, or 1.8 V) through jumper
J13.

Note: An additional on-board LDO (U9 — not shown in Figure 3-1) generates a fixed 3.3-V supply for the PSoC 5LP in the
CY3677 Rev ** EVK. This feature has been changed in CY3677 Rev *A EVK where the PSoC 5LP is directly powered by a
5-V USB supply. The CY3677 kit revision is printed on the label at the back of the kit box.

Figure 3-1 illustrates the block diagram of the CY3677 EVK.
Figure 3-1. CY3677 EVK Block Diagram
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3.2 Functional Description

The differential clock outputs (J7, J8) and single-ended output (J10) are driven out on to SMA connectors. The EVK is
populated with 50-Q resistors (R30 and R31) for output termination. The termination options of the differential outputs on the
evaluation board are listed in the Hardware chapter. These termination circuits are designed to terminate the output clocks in
LVPECL, LVDS, HCSL, LVPECL2, and CML signal types by populating, or by not populating the J5 jumper shunt. The single-
ended (LVCMOS) clock does not need any on-board termination settings.

Figure 3-2 illustrates the top view and bottom view of the CY3677 EVK.
Figure 3-2. CY3677 EVK (Top View, Bottom View)

"

CY3677 EVK Bottom View

CY3677 EVK Top View

3.3 CY3677 EVK USB Connection

The CY29430 clock device on the kit is loaded with a default configuration. To view and evaluate other configurations on an
oscilloscope (or other standard instruments), the clock device must be programmed with the desired configuration. The
ClockWizard 2.1 application is required for programming any configuration. Therefore, the kit should be connected (see

Figure 3-3) to a PC through a USB port for programming.
Figure 3-3. Kit Connected through USB

CY3677 Evaluation Kit User Guide, Doc. No. 002-12185 Rev. *D 14
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The kit enumerates as a USB Composite Device as part of the Driver Software installation on Windows.

Figure 3-4. USB Driver Installation

- Driver Software Installation &
Installing device driver software
USB Composite Device «/ Ready to use
KitProg USBUART (_J Searching Windows Update...
KitBridge (_J Searching Windows Update...
KitProg Programmer (s Searching Windows Update...
Obtaining device driver soft from Windows Update might take a while. |
Skip obtaining driver software from Windows Update

|
Close

After the driver installation is complete, the device is ready to use.

Figure 3-5. USB Driver Installation Complete

| Driver Software Installation @
Your device is ready to use
USE Compaosite Device +f Ready to use
USB Input Device JRead}rto use
KitProg (1.2.3.3) +f Ready to use
KitPreg USB-UART (COM32) —J"'Read}r to use

U

3.4 Programming the CY29430

The CY29430 device has an internal one-time programmable (OTP) nonvolatile memory called eFuse. The device also
contains volatile memory that stores an exact copy of the eFuse at the release of reset at power-up. The output frequency
depends on the configurations in the volatile memory. Writing the entire device configuration in the volatile memory section
of a blank device after power-up, is called Functional Programming. The CY3677 kit is shipped with a programmed CY29430
device. This program is written to a specific internal memory location of the device. This kit can be used to check both the
Functional and eFuse Programming of the device using ClockWizard 2.1. See Functional Programming of the CY29430 and
eFuse Programming of the CY29430 for details.

CY3677 Evaluation Kit User Guide, Doc. No. 002-12185 Rev. *D 15
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3.5 Functional Programming of the CY29430

ClockWizard 2.1 is used for functional programming of the CY29430. A configuration created in ClockWizard 2.1 can be
downloaded to the volatile memory section of the device.

The example ClockWizard 2.1 projects can be found at the following location:
<Install Directory>\CY¥3677 Evaluation Kit\<version>\Firmware\Example Projects

Configuration profiles generated from these projects can be used to evaluate the CY29430 device on the CY3677 EVK. Refer
to Functional Programming for the kit's hardware settings prior to programming. It is recommended that you copy the example
projects to another location if you want to make any modifications to the settings so that the default project is retained in the
installation directory.

Before programming the CY3677 EVK through ClockWizard 2.1, it is recommended to go through
the Hardware section of this user guide. A mismatch between the hardware settings and the

CAUTION ClockWizard 2.1 configuration may cause potential damage of the EVK. Specifically, the voltage
setting on the kit selected with J13 must match the voltage setting within the configuration to be
programmed.

3.5.1 Generating and Programming the Device Configuration Profile
The ClockWizard 2.1 is used to generate profiles and to perform functional programming of the device.

1. Verify that the power supply voltage jumper (J13) is set for the voltage used in the project that you intend to program.
See the Hardware section for details.

2. Connect the CY3677 EVK to your PC through the supplied USB cable.
3. To launch the ClockWizard 2.1 application, go to Start > All Programs > Cypress > ClockWizard 2.1.
The workspace files are located in the Workspace folders. The four workspaces available are:

CY3677_LVPECL_3p3.cpj
CY3677_LVDS_2p5.cpj
CY3677_HCSL_2p5.cpj
CY3677_LVCMOS_1p8.cpj

4. Select the File menu in ClockWizard 2.1, select Open workspace, browse the required workspace file with a .cpj
extension, and then click Open. Each Workspace file can contain multiple projects.

5. Click Configure, as shown in Figure 3-6. The various configuration parameters appear on the right panel of the block
diagram in the tabbed interface. For more information on configuration parameters, refer to the ClockWizard 2.1 User
Guide located in Help > User guide of the ClockWizard 2.1 software.

6. Click the Generate button (see Figure 3-6). This will generate the JEDEC file for the configuration selected. On
completion of generation, the Results are displayed as shown in Figure 3-7.
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Figure 3-6. Generating a Configuration Profile using ClockWizard 2.1

fief ClockWizard 2.1 - CY3677_LVPECL_3p3.cpj (=[@] = J
File Tools Help
Padd
Home Output [ common | Option |
1= Projects Parameter Value
=) Project_00 - CY29430 Output Frequency 0 (MHz) EkEEXS
Qutput Frequency 1(MHz) |50
Results Output Frequency 2 (MHz} | 100
Program Output Frequency 3 (MHz) | 156.25
CLKP
—XIN INPUT PLL OouTPUT >
CKSE
Output Frequency 0 (MHz)
Valid Range
(CMULVPECLLVPECLZHCSLILVDS): 15MHz
-2100MHz
Generate | CMOS: 15MHz -250MHz.
age
=

7. Click Results in the navigation pane to view the results at any time after a JEDEC file has been generated for a
configuration, as shown in Figure 3-7.

Figure 3-7. View Results Generated from the Configuration Profile using ClockWizard 2.1

s S
i ClockWizard 2.1 - CY3677_LVPECL 3p3.cpj e o
File Tools Help
Badd
Home Input and output JEDEC file: Project_00 jed
= Projects Greated on 10/24/2016 2:08 PM
=) Project_00-CY29430 | output Frequency Target Frequency (MHz) E’)ﬂa':caulated Lisgaeacy PP Error Register programming details
Configure
m Profile 0 33333 32.332909970867 -0.000874 Device slave adaress: 0x55
Program Profile 1 50 409999999532 -0.000936 Registername Address Value |2
Profile 2 100 99.9999999193 -0.000807 DIVO_FsS0 Ox10 0xCD
Profile 3 156.25 156.249999863906 -0.000871 DIVN_FS0 0x11 ox3c
DIVO_MISC_... 0x12 Ox0A
Common ) DIVN_FRACO.. 0x13  0xF@
Seftings Category Setiings DIVN_FRACT. Ox14  0x9B
Ref Clock Type OT3 XTAL DIVN_FRACZ.. 0x15 OxCA |
Reference Input (MHz) 114.285 DIVO_Fs1 0x20 0x89 3
DIVN_Fg1 0x21 x3c
XO_Doubler Disable DIVO_MISC_.. 0x22 0X0A
Common Output Standard LVPECL DIVN_FRACO.. 0x23 0x6C
QE Polarity Active Low DIVN_FRACT .. 0x24 0x18
12C Address (decimal) 85 DIVMN_FRACZ... 0x25 0xFO
VDD 23y DIVO_FS2 0630 0xdS
VKO Disable DIVN_FS52 0x31 0x3C
DIVO_MISC_. 0x32 Ox0A
VCXO Bandwidth 10KHz DIVN_FRACO. 0633 0xBA
Total Pull Range 150 ppm DIVIN_FRAC1... 0x34 018
VCXO Gain Polarity Positive DIVN_FRAC2... 0x35 x50
Option USER_DATA_1 (0xD4) o DIVO_FS3 Oxd0 x2c
USER_DATA_2 (0xD5) 0 DIVN_FS3 Oxd1 0x3C
USER_DATA_3 (0xDE) 0 DIVO_MISC_... 0x42 Ox0A
DIVN_FRACO... 0x42 OxAZ i
F i ———
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8. To program the CY29430 device, select Program in the left navigation pane, as shown in Figure 3-8. Choose the
appropriate device in the Select Device (I12C Master) drop-down list prior to programming, and then click the Functional
Program button. This will program the device directly from ClockWizard. LED1 blinks to indicate that the device is being
programmed. The required output will appear on the oscilloscope.

For more information, refer to the ClockWizard 2.1 User Guide located in Help > User guide of the ClockWizard 2.1
software.
Figure 3-8. Programming Configuration Profile using ClockWizard 2.1
i ClockWizard 2.1 - CY3677_LVPECL 3p3.cpj =8 %
File Teols Help
S
a :’:';l Program - Project_00
c] Project_00 - CY29430 Device selection JEDEC programming
Configure I Select Device (12G Master) I [m Select JEDEC [Project 00 -
ﬁ (L srussrroman || runctonatprogiam |
33333 Enable 00
H: 50 Positive
- g 50 Small change update
H 156.25
Large change update
VTI]’EI’ Apply
£
Info: Device is not eFused
9.

The CY29430 supports the selections of four frequency profiles for a single configuration. The Frequency Select inputs

of the CY29430 device (FSO and FS1) can either be controlled by ClockWizard 2.1 or they can be hard-coded using
jumpers on the board. To allow selection of a frequency profile in ClockWizard 2.1, jumpers J14 and J15 must be set to
positions 2 and 3. With the jumpers in those positions, you can select any of the four available profiles in ClockWizard
2.1 and click Apply (see Figure 3-9). Refer to the section Frequency Select (FS) for details on the hardware settings.

Figure 3-9. Frequency Select (FS) Operation of the CY29430 device through ClockWizard 2.1

i ClockWizard 2.1 - CY3677_LVPECL 3p3.cpj

=) Project_00 - CY29430 Device selection
Configure

Select Device (I2C Master).
Results

Large change programming

Profile 0 (MHz). 33333 VCXO:

Frequency select signal
FS1:FS0:

o0

[ 'H Apply ﬂ

=

Info: Device is not eFused

info: Programming started for Project_00 at 1213/2016 1:00:32 PM
info: Programming operation completed successfully

KitProg/100F0D28010D5400 ~| Select JEDEC:

JEDEC programming

[Project 00 -

l

[

eFuse Program | [ Funlional Program |

Disable
Profile 1 (MHz): 50 Gain polarity: Positive
Profile 2 (MHz): 100 Total pull range (ppm): 150
Profile 3 (MHz): 156.25 VCXO BW (KHz): 10

Small change pragramming
Select FS profile:

Small change {ppm):

Small change update

(=] [
File Tools Help
g&da
Home ]
3 Projects Program - Project_00
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10. After functional programming, the frequency values of the current .cpj are displayed in the following fields (see Figure
3-10): Profile 0 (MHz), Profile 1 (MHz), Profile 2 (MHz), and Profile 3 (MHz). You can change any of the frequencies

in these fields. To make the changes effective, click Large change update. The expected output frequency will appear
on the oscilloscope.

Note: Large change programming refers to the case where the frequency is changing more than = 500 ppm.

Figure 3-10. Evaluation of Other Frequencies through Large Change Update

J ClockWizard 2.1 - CY3677_LVPECL 3p3.cpj

[ 5] [ |

File Tools Help
a4l
Home -
3 Projects Program - Project_00

= Project_00 - CY29430 Device selection JEDEC programming
Configure

Select Device (12C Master): KitProg/100F0D28010D5400 | Select JEDEC: [PIOJECLUU v]
Results

| eFuseprogam || Functional Frogram |

Large change programming

Small change programming

Disable Select FS profile

Profile 1 (MHz): Gain polarity: Positive

Profile 0 (MHz): 33333 VCXO:

Small change (ppm):

Total pull range (ppm) 150 Small change update

Profile 3 (MHz): VCXO BW (KHz): 10

Large change update

Profile 2 (MHz)

Frequency select signal

FS1FS0:  [00 NI

Info: Device is not eFused
Info: Programming started for Project_00 at 12/13/2016 1:00:32 PM
Info: Programming operation completed successtully

11. If you want to change the frequency to less than 500 ppm, fill in the desired ppm in the Small change (ppm) field,
Select FS profile and click on Small change update. The settings are shown in Figure 3-11.

Figure 3-11. Evaluation of Other Frequencies through Small Change Update

i ClockWizard 2.1 - CY3677_LVPECL 3p3.cpj

[=/E] =

File Tools Help

[l ]
Home
3 Projects Program - Project_00
(=] Project_00 - CY29430 Device selection JEDEC programming
;D"ff“m Select Device (12C Master) Select JEDEC: [Project 00 -]
esuls

[ &Fuse Program ” Functional Program ]

Large change programming Small change programming

Profile 0 (MHz):  33.333 VCXO: Disable Select FS profile:
Profie 1(MHz): 50 Gain polarity: Positive Small change (ppm): 100

Profie 2 (MHz) 100 Total pull range (ppm) 150
Profie 3(MHz) 15625 VCXO BW (KHz): 0

Large change update

Frequency select signal

FS1FSO: 00 ‘] [ Apply ]

=

Info: Device is not eFused

Info: Programming started for Project_00 at 121312016 1:00:32 PH
info: ing operation
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3.6 eFuse Programming of the CY29430

After functional programming and evaluation of different clock configurations, you may choose to write the configuration to
the nonvolatile memory section of the device. The nonvolatile memory of the CY29430 is a one-time programmable (OTP)
eFuse. Any configuration after functional evaluation can permanently be written to the eFuse of the device. See Figure 3-12
for the programming procedure.

Configure the device supply to 2.5 V before starting the eFuse programming. Table 4-2 provides the hardware configuration
(J13 settings) of CY3677 for setting the device supply to 2.5 V.

Figure 3-12. eFuse Programming using ClockWizard 2.1

i ClockWizard 2.1 - CY3677_LVPECL 3p3.cpj

File Tools Help
g & P

Home

B Projects Program - Project_00

= Project_00 - CY29430 Device selection JEDEC programming

Select Device (12 Master): Select JEDEG [Project 00 -

|[ eFuse Program || Functional Program |

Configure

Results

22333 | eFuse programming == 00
50 _ h 100
@) You are 2bout to permanently program the device. Do you want to
100 . 4 centinue? Small change update
156.25
) =

=

Info: Device is not eFused

Info: Programming started for Project_00 at 12/13/2016 1:00:32 PM
Info: Programming operation completed successfully

Info: Device is not eFused

Evaluate the configuration via functional programming prior to writing a configuration to the
eFuse. The configuration cannot be modified or erased once it is written to the eFuse.

CAUTION
The CY29430 supply must be set to 2.5 V for eFuse programming. Setting the CY29430 supply to

any other voltage during eFuse programming will cause potential damage to the device.

After the device is eFuse-programmed, you can only change the output frequency through the following ways. Note that these
changes will revert after a power cycle.

= Large change programming: This refers to the case where the frequency is changing more than 500 ppm. Enter the
desired frequencies in the Profile 0 (MHz), Profile 1 (MHz), Profile 2 (MHz), and Profile 3 (MHz) fields, and click on
Large change update. The device will recalibrate and reconfigure the internal circuit and the output will change to the
desired frequencies.

= Small change programming: This refers to the case where the frequency is changing less than +500 ppm. Select FS
profile, enter the desired ppm in the small change (ppm), and click on Small change update. The device will recalibrate
and reconfigure the internal circuit and the output will change to the desired frequencies.

3.7 Custom Profile Generation

ClockWizard 2.1 should be used to generate custom configuration profiles. For details on how to create custom profiles, refer
to the ClockWizard 2.1 User Guide located in Help > User guide of the ClockWizard 2.1 software.

To understand the output termination settings of different output standards (for example, LVPECL, HCSL, or LVDS), refer to
the B.1. Termination Settings of Differential Clock Outputs section.
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4.1 Board Overview

The CY3677 EVK is used for evaluating the CY29430 device.

Following are the key features of the CY3677 EVK:

e Powered from a USB port

e Jumper to configure on-board LDO output

e Jumper to short or isolate external connection for termination settings

Figure 4-1 illustrates the CY3677 EVK board with a markup of the on-board components.
Figure 4-1. CY3677 EVK On-board Components

Main Power OE Control : 3
Supply Jumper (J1) (J16)

External Clock
Reference (TCXO)

LDO Jumper Power LED
Settings (J13)
) Single-Ended
USB Mini-B [ Clock Output
Connector (LVCMOS)
Frequency
Select Jumpers :
(J14, 115) | Differential
Clock Output
Status LED o
Termination
Jumper (J5)
CY29430FLQXI
PSoC 5LP VCXO Input - Crystal* * Components are on the bottom-side
(CY8C5868LTI-LPO39)*  (2) of the Evaluation Board
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Table 4-1: CY3677 EVK Onboard Components Description
Label Name Description
CY29430FLQXI CY29430FLQXI is the Cypress clock chip that is evaluated with the CY3677 EVK.
Main Power Supply Jumper (J1) Short pin 1 and 2 of jumper J1 to power up the CY29430. The core supply and I/O

supply are shorted on the board, and hence are the same for the device.

Set the J13 jumper per Table 4-2 to set the LDO output voltage.

Note: The brightness of LED2 will vary depending on the voltage selection. It will be
brightest at 3.3 V and dimmest at 1.8 V.

LDO Settings Jumper (J13)

USB Mini-B Connector Connect the kit to a PC using the USB Standard-A to Mini-B cable.

Connect SMA cables to the SMA connectors (J7 and J8) on one end and to an

Differential Clock Output oscilloscope on the other end.

Connect the SMA cable to the SMA connector (J10) on one end and to an oscilloscope

Single-Ended Clock Output (LVCMOS) on the other end

Connect the SMA cable to the SMA connector (J11) on one end and to an external

External Clock Reference (TCXO) clock reference (TCXO) on the other end.

Termination Jumper (J5) The board has an on-board jumper (J5) to connect and disconnect output termination.

Status LED Thi_s LED (LEDl)_turns ON after the USB_enumeration is completed. This LED blinks
during programming of the CY29430 device from a PC.

Power LED This LED (LED2) turns ON when the CY29430 device is powered.

OE Control (J16) Jumper to set the OE input of the CY29430 to enable or disable the clock output.

Frequency Select Jumpers (J14, J15) J14 and J15 are used to set the frequency select bits of CY29430.

Crystal On-board 114.285 MHz OT3 crystal for the reference input of the CY29430 device. This

crystal has frequency tolerance of +20 ppm.

On-board PSoC 5LP device that converts the USB data-stream to 12C format to program

PSoC 5LP (CY8C5868LTI-LP039) the CY29430 device

This jumper can be used to evaluate the VCXO operation of the CY29430 device. Vc
(voltage at J2.1 pin) is by default set to 0 V via a jumper shunt. You can remove the
shunt and instead apply an external power supply voltage (DC) to pin J2.1 to evaluate
VCXO Input (J2) the VCXO operation.

Cypress recommends that you contact our Technical Support team at
www.cypress.com/support before connecting any external power supply to this jumper.

Table 4-2: J13 Jumper Settings

J13 Settings LDO Output Voltage (Supply of CY29430)
Short pin 1 and 2 25V
Short pin 2 and 3 (default) 3.3V
Open 1.8V

The kit should strictly be operated from a USB supply by connecting to a PC.

The PCB should not be powered by any external source. Application of an external power source
to any of the jumper pins or test points may cause potential damage of the PCB.

CAUTION To configure the device to a clock standard other than those specified in the example projects, or
to apply custom termination voltage, go to our support web page at www.cypress.com/support, or
e-mail at: clocks@cypress.com.

Incorrect application of supply or termination voltage will cause performance degradation of the
clock output. Prolonged incorrect operation may permanently damage the kit.
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4.2 Board Details

4.2.1 Default Jumper Settings

The CY3677 EVK comes with default jumper settings that set the 1/0 and core supply voltages as 3.3 V. Table 4-3 lists the
default jumper settings.

Table 4-3: Default Jumper Settings on the Kit

Jumper Default Settings Description
Ji Pin 1 and 2 are shorted Power on CY29430.
J2 Pin 1 and 2 are shorted VCXO input setto 0 V.
J5 Pin 1 and 2 are shorted CY29430 output termination voltage set to 0 V through the 50-Q termination resistors.
J13 Pin 2 and 3 are shorted 3.3V selected for CY29430.
Ji4 Pin 1 and 2 are shorted FS1 setto VDD_DUT (logic ‘1’).
Ji5 Pin 1 and 2 are shorted FSO set to VDD_DUT (logic ‘1).
J16 Pin 2 and 3 are shorted OE pin set to 0 V (logic ‘0’).

4.2.2 Power Settings

The only power option of this EVK is 5 V that comes from a USB port. The device has the same core and I/0O supply voltage.
The supply voltage of the device can be selected from on-board generated supplies of 1.8 V, 2.5V, or 3.3 V.

Table 4-2 lists the hardware settings required for power selection.

The J13 selection must match with the software configuration of the supply voltage during
functional programming and must be set to 2.5 V during eFuse programming. Mismatch between
the J13 setting and ClockWizard 2.1 setting may cause incorrect output or reliability problems
with the device.

CAUTION

4.2.3 Functional Programming

The board should be connected to a PC through a USB connector to configure and program the device. Refer to the CY3677
EVK USB Connection section to learn how to connect the kit to a PC. Figure 4-2 illustrates the programming section of the
kit.

Figure 4-2. Programming the CY29430 Device

BC V. =18V/25V/33V
LDO
(configurable
output)
USB
Connection sy CY29430
(I3) ’ Ul
D+ —_—
PSoC 5LP
(USB to I'C
Bridge)

The USB interface provides a 5-V power supply. The PSoC 5LP converts the JEDEC profiles into an 1°C-compatible format,
which is then loaded into the CY29430 clock device.

Note: During functional programming, keep the power supply of the CY29430 device (hardware settings) the same as in the
ClockWizard 2.1 configuration (software settings). Table 4-2 provides the supply settings for the CY29430. During eFuse
programming, set the power supply of the CY29430 to 2.5 V.

The Example Projects section provides the example projects (.cpj files) created in ClockWizard 2.1.
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4.2.4 LED Indicators
Table 4-4: LED Indicators

LED Label Indicator Description

This LED turns ON when the kit is connected to the USB port on a PC using the cable
provided.

If this LED does not turn ON, it indicates that the USB enumeration of the kit did not
happen with the host PC. This LED blinks continuously when the device is being
USB Power and programmed through the PSoC 5LP device.

Status Note:

This LED may glow with low intensity under the following condition:

The CY29430 supply is disconnected through the jumper (J1). This low-intensity LED
glow may be misleading to the user on the status of the USB connection to the board.
It is, therefore, recommended to avoid this condition during use of the kit.

LED1 | USB_PWR_LED

This LED turns ON when the core of the CY29430 device is powered. Ensure that a
Clock Device jumper shunt is populated or not populated on J13 per Table 4-2 for proper supply of
Power CY29430.

The intensity of this LED for 1.8 V is lower compared to 2.5 V and 3.3 V.

LED2 POWER_LED

4.2.5 On-Board Crystal

This EVK is populated with a Third Overtone Crystal (OT3) of 114.285 MHz. This crystal has a frequency tolerance of
+20 ppm. It serves as a clock source for the CY29430 device.

4.2.6 TCXO Input Reference

The CY29430 device can also be evaluated with external TCXO reference. The external reference clock source must be
connected to the SMA connector J11. To activate the TCXO reference clock effective to the CY29430 device, desolder the

resistor R40, and populate the 0-Q resistor R42. R40 and R42 are located on the secondary side near the Y1 crystal.

4.2.7 Frequency Select (FS)

The volatile and the nonvolatile memory of the CY29430 device stores four frequency profiles. The Frequency Select inputs
of the device (FSO and FS1) can be controlled by the on-board jumpers J14 and J15. FSO and FS1 can also be configured
using ClockWizard 2.1. Refer to Table 4-5 for the Frequency Select operation.

Table 4-5: Jumper Settings for Frequency Select

Jumper Settings for .
FS Input (logic) to

Hardware Clontrol of FS Jumper Settings for ClockWizard 2.1 Control of FS Bits AR Frequency
Bits Profile
J14 J15 J14 J15 ClockWizard 2.1 Settings Selected
) ) . . FS1_DUT | FSO_DUT
Settings Settings Settings Settings = =
Select FS1:FS0: as 00 and
Open Open click Apply 0 0 0
Short pin 1 Select FS1:FSO0: as 01 and
Open - 0 1 1
and 2 Shortpin2 | Shortpin2 | Slick Apply
i and 3 and 3 . .
Short pin 1 Open Sglect FS1:FSO: as 10 and 1 0 2
and 2 click Apply
Shortpin1 | Short pin 1 Select FS1:FS0: as 11 and 1 1 3
and 2 and 2 click Apply

Note: The Hardware and ClockWizard 2.1 control are mutually exclusive and only one works at a time
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4.3 Evaluating Different I/O Standards Using the CY3677 EVK

The CY29430 device has one differential clock output pair (CLK_P and CLK_N) and one single-ended clock output (CLK_SE).
The onboard components of the CY3677 can be configured to different settings for evaluating different clock standards.

Figure 4-3 and Table 4-6 illustrate the on-board components related to the CY29430 output clocks.
Figure 4-3. CY3677 Output Termination Settings

Three on-board components J5,
R30, and R31 set termination of
CLK_P and CLK_N.

Table 4-6: CY29430 Clock Outputs

Clock Output CY29430 Pin SMA Connector on CY3677 Resistor to Set Termination (50 Q)

CLK_P 10 J8 R30
CLK_N 9 J7 R31
CLK_SE 11 J10 NA

The CY29430 device supports LVPECL, LVDS, HCSL, LVPECL2, and CML differential output types. R30 and R31 are the
on-board output termination resistors. The termination settings are controlled by the J5 jumper shunt. The typical laboratory
setup for the evaluation of this kit is shown in Figure 4-4. See Table 4-7 to set correct on-board termination option of CLK_P
and CLK_N.

Table 4-7: J5 Jumper Settings to Terminate Differential Clock Outputs

10 Standard J5 Jumper Position Description
LVPECL, HCSL Short CLK_P and CLK_N termination voltage set to 0 V through the 50-Q termination resistors.
LVDS Open 100 Q differential impedance between the CLK_P and CLK_N.

If you want to configure this kit to any other mode, or any other termination setup, it is
recommended to contact our support through the www.cypress.com/support web page, or e-mail

CAUTION at clocks@cypress.com.

J5 should not be powered by any external source. Connection of external power source may
damage the EVK.
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Figure 4-4. CY3677 EVK Connected to an Oscilloscope
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5.1 Example Project Configuration Details

The CY3677 EVK can be evaluated with example projects that configure the device with different output types and frequency
profiles. Each example project corresponds to a particular device configuration. This section provides the configuration details
of each example project. The configuration generated from the example projects needs to be downloaded to the device and
to be evaluated with on-board termination options. All the example projects are located at:

<Install Directory>\CY3677 Evaluation Kit\<version>\Firmware\Example Projects

The device is loaded with the default configuration of 114.285 MHz LVDS output for 3.3-V VDD. To evaluate the example
projects, follow the steps described in the Programming the CY29430 section and refer to the Hardware and Software settings
provided in Table 5-1 for programming and evaluation.

Table 5-1: Example Project Details

Software Configurations Hardware Settings g\;?:lilljlﬁtslgggz
Set Set
Set FS1 | Set FSO Expected
VDD_DUT VCM Output Peak-to-
Exar_nple 1/0 Type VDD Setup Frequency Peak
Project J13 J5 J14 J15 MHzZ Volt
Jumper Jumper Jumper Jumper ( ) @ \a/ge
Position Position Position Position (mV)
Open Open 33.333
Open land2 50
EZEGEELVF LVPECL | 33V | 2and3 Short 375 to 450
—3P3.Cp) land?2 Open 100
land2 land2 156.25
Open Open 33.333
Open 1and 2 Connect SMA cables to J7 and 50
(L:Y2365YZ—.HCS HCSL 2.5V land?2 Short J8, and connect the other ends 3750 430
—<P>-Cp) land 2 Open to an oscilloscope. 125
land2 land2 100
Open Open 133.33
Open 1and?2 100
cvgeg 7_LVD LvDs | 25V | 1land2 Open 385050
S_2p5.cpj land 2 Open 156.25
1land2 1and?2 50
1. Connect an SMA cable
19.2
Open Open between J11 and 52-MHz o
Open 1and2 TCXO reference source. 38.4
2. Connect an SMA cable
,\Cﬂg’smf —SL\C/C. LVCMOS | 1.8V Open NA land 2 Open between J10 and the 52 155 t0 175
—PS-CP) oscilloscope.
3. Desolder the resistor, R40.
Land2 Land2 4. Populate 0 Q resistor, R42. 26

The peak-to-peak voltage provided in Table 5-1 will vary with different types of oscilloscope probes, scope-termination, and
type of coupling used during measurement. These measurements are done using an 8-GHz oscilloscope, SMA cables, 50-Q
scope termination, and DC coupling. Sample example project outputs are shown in Figure 5-1 through Figure 5-4.
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Figure 5-1. LVPECL 3.3 V, 156.25 MHz Clock Measured with DC Coupling, 50-Q Scope Termination

SBIW [E2ILAA

Measureme
© Vamptd(l) ® 240042 mV .03 mV 24515 mV
© Frequency(l) 156.22428 MHz 156.25324 MHz 156.13280 MHz 156.37262 MHz
© Vamptd(2) 44515 mV 442,665 mV 43672 mV 44852 mV
© Frequencyi2) 156.19981 MHz 156.25307 MHz 156.16088 MHz 156.34858 MHz

SIUBLIBINSER I

SEal [eDILaA

Measurement
9 Vamptd(l) ® 421.54 mV 419.785 mV 41648 mV 42323 mV
© Frequency(l) 100.00968 MHz 100.00233 MHz 99.966915 MHz 100.04064 MHz
© Vamptd(2) 421.54 mV 421.845 mV 41817 mV 42492 mV
© Frequency(2) 100.00321 MHz 100.00261 MHz 99.960710 MHz 100.04202 MHz

SIUBLIBINSES |
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Figure 5-3. LVDS 2.5 V, 50 MHz Clock Measured with DC Coupling, 50-Q Scope Termination

Demos Help

SE3l [EDILBA |Seapy 2wl

@ Vamptd(l) ® 45189 mV 515 mV 50417 mV.
@ Frequency(l) 49598360 MHz 50.001008 MHz 49.987967 MHz 50.011223 MHz
© Vamptd(2) 52440 mV/ 446975 mV 42997 mV 52777 mV.

Frequency(2) 50.003217 MHz 50.001056 MHz 49986826 MHz 50.016597 MHz

Measurement
Frequency(3) 12 26.000640 MHz .081585 MHz 26.021645 MHz

Vamptd(3) @ 1.66594 V 1.66302 V 164570V 168617 V.
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Example Projects

5.2 Evaluation of VCXO Functionality

You can edit any of the four example projects described in Section 5.1 to evaluate the VCXO functionality of the CY29430
device. Following is an example to evaluate the VCXO functionality:

1. Open the example project CY3677_LVPECL_3p3.cpj using ClockWizard 2.1. Refer Table 5-1 for the required jumper
settings of this project.

2. Select Configure in the left navigation pane. Click the Common tab.

Change VCXO settings from Disable to Enable. Select Total Pull Range to 275 ppm, and VCXO Gain Polarity to
Positive. Click the Generate button. The settings is shown in Figure 5-5.

Figure 5-5. VCXO Settings of Total Pull Range 275 ppm, and VCXO Gain Polarity Positive

= B [ |

P
i ClockWizard 2.1 - CY3677_LVPECL _3p3.cpj

File Toocls Help

@&+ d

Home
2 Projects
=) Project_00 - CY29430

Results

Program

XM

INPUT

PLL

ouTPUT

CLKN

f=thl .

(CLEP o

CKSE

=i

Generate

input | output] Common § option|

CommonSettings

Category

Output Standard

LVPECL

OE Polarity

Active Low

12C Address (decimal)

85

VDD

VCXO

33v

Enable

VCXO Bandwidth

10 KHz

Total Pull Range

275 ppm

I El KN E

VCXO Gain Polarity

Positive

VCXo

This option selects Enable or Disable YCXO feature

4. Select Program in the left navigation pane, and click the Functional Program button.
Click on Large change update.

6. Measure frequency using a standard instrument (for example: an oscilloscope of bandwidth 8 GHz, frequency counter,
or Signal source analyzer). The frequency changes from 156.25 MHz to 156.20 MHz.

7. Repeat Step 2.

8. Select VCXO Gain Polarity to Negative. Click the Generate button. The settings is shown in Figure 5-6.
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Figure 5-6. VCXO Settings of Total Pull Range 275 ppm and VCXO Gain Polarity Negative

it ClockWizard 2.1 - CY3677_LVPECL 3p3.cpj SRRC X

File Tools Help

Sgdd

Home | input | output| Common | option

=) Projects CommonSettings Category

) Project_00 - CY29430 Oulput Standard LVPECL [~]
O Poarty T

Results 12C Address (decimal) |85

T —

Program

VCXO Enable
VCXO Bandwidth 10 KHz.
Total Pull Range 275 ppm
VICXO Gain Polarity Negative

I ENE

CLKN

PLL ouTPUT  [E—

CKSE

—AN o INPUT

VCXO Gain Polarity
This option selects the VCXO Gain Polarity

Generate

Messages
=

9. Repeat Step 4 and 5.

10. Measure frequency using a standard instrument (for example: an oscilloscope of bandwidth 8 GHz, frequency counter,
or signal source analyzer). You will see the frequency has changed from 156.25 MHz to 156.30 MHz.

The measured frequencies 156.20 MHz and 156.30 MHz are the minimum and maximum frequencies that can be
controlled through VCXO operation.

If you want to evaluate the Phase Noise plot of the CY29430 device in CY3677 EVK for any project
with the VCXO parameter set as Enable through Functional Program, it is required to do Large
change update prior to taking Phase Noise plot.

User can directly take Phase Noise plot of the CY29430 without doing Large change update if the
CAUTION device is eFuse programmed.

VCXO input jumper J2 should not be powered by any external source. Incorrect connection of

external power source may damage the EVK. If user wants to apply any external source for

VCXO evaluation, it is recommended to contact our support through the

www.cypress.com/support web page, or e-mail at clocks@cypress.com.

Note [1]: The default 114.285-MHz LVDS profile programmed into the device does not have the OE functionality enabled.
Hence you cannot control it through the J16 jumper.

Note [2]: If you want to evaluate the OE functionality of the device through the functional programming by setting OE as
Active High in the ClockWizard project, it is recommended to populate the J16 jumper between pin 2 and 3 to disable the
clock, and to remove jumper J16 to enable the output clock.

The example projects provide instruction guidelines for four I/O standards (HCSL, LVPECL, LVDS, and LVCMOS). Other
than these four I/O standards, the CY29430 supports other standards such as CML and LVPECL2. Evaluation of these two
configurations needs additional laboratory setup and oscilloscope adjustments. Cypress recommends that you contact
Cypress Technical support through the www.cypress.com/support web page, or e-mail at clocks@cypress.com if you are
evaluating the CML or LVPECL2 1/O standard or want to use different coupling, or any other termination voltage that is not
part of these example projects.

Any of the four example projects provided in this document, or a project you created can be permanently programmed to the
nonvolatile memory. Refer to the eFuse Programming of the CY29430 section for the required guidelines on using this feature.
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A.1. BCP Script to Disable the Default Power-up Profile of CY29430

The CY3677 EVK is shipped with a programmed CY29430 device. This program is loaded in a particular memory location of
the CY29430 device so that the on-board crystal frequency (114.285 MHz) comes out at CLK_P and CLK_N. This is the
default power-up profile of the CY3677 EVK. But this power-up profile disables the OE functionality of the CY29430 device.
This profile also has impact on the VCXO performance of the CY29430 device. Hence the output clock will show higher RMS
Phase Jitter if VCXO is set Enable through ClockWizard 2.1.

To disable the default power-up profile of the CY29430 device, execute the following script in the Bridge Control Panel tool:

1.
2.

Ea

5
6
7.
8
9

Create a file with a name of your choice and the extension .iic (for example, “myfile.iic”).
Write the following set of commands in your .iic file:

w 55 63 00

w 55 63 01

[delay=1]

w 55 d7 CO

[delay=5]

w 55 61 00

w 55 61 03

[delay=5]

w 55 61 00

Open the Bridge Control Panel utility from All Programs > Cypress > Bridge Control Panel > Bridge Control Panel.

Click on the specific KitProgl... device in the connected 12C/SPI/RX8 Ports. The connected indicator is displayed in
green color indicating the device is connected successfully (see Figure A-1).

Go to File > Open File > .iic. The sequence of commands will appear in the editor, as shown in Figure A-1.
Check the Send all strings box, as shown in Figure A-1.

Click the Send button, as shown in Figure A-1.

Close the Bridge Control Panel.

Power cycle the CY29430 device.

Note: The device will permanently switch back to the unprogrammed state and will not show any default clock output during
power-up. But you can perform all possible programming using the ClockWizard 2.1 tool, and evaluate the CY29430 device
in the CY3677 EVK.
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Figure A-1. BCP Script to Disable the Default Power-up Profile of CY29430

¥ Bridge Control Panel | = @ | X

File Editor Chart Execute Tools Help
BEEH SRR SEEEER
Editor | Chart | Table | File |

w 55 63 00
w 55 63 01
[delay=1]
w 55 d7 c0
[delay=5]
w 55 61 00
w 55 61 03
[delay=5]
w 55 61 00

| »

1

4 b

Opening Port -
Successfully Connected to KitProg/161BOACB00086400
KitProg Version 2.17
Devices list: Bbit 7bit

address: AA 55
w 55+ 63+ 00+ p
w 55+ 63+ 01+ p
[DELAY=1] i
w 55+ D7+ CO+ p
[DELAY=5]
w 55+ 61+ 00+ p
w 55+ 61+ 03+ p
[DELAY=5]

w 55+ 61+ 00+ p 4 P
4 p 2
Connected 12C/SPI/RXS Ports:

- Send all strmg KitProg/161B0ACB00036400 Protocol
[ @ Reset B List & send ol @ 12¢c
Repeat count: COMS SPI
RX8 (UART)

[=] Stop W Repeal .To file
- Scan period, ms: l
|1 117 | Syntax : OK |0k ﬁ\mme! 2584 mvV
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B.1. Termination Settings of Differential Clock Outputs

The CY29430 device supports four high-speed differential I/0 standards.
Figure B-1 illustrates industry standard differential termination techniques for reference.

Figure B-1. Recommended Differential Termination Scheme for DC/AC Measurements

|
|
|
|
I
|
Receiver Transmitter Receiver :
1
|
|
|
|
500 50Q :
|
|
|
|
= Voo =2V £ :
I |
: |
|
I
| V“D Vnn :
I |
I 330 I
! \/
[ VY 500 500 |
I
| [Transmitter Receiver :
| 330 |
: |
1 Receiver :
I |
I @ "
| 50Q "
| |
| |
| |
I |
I |
l |
I |
l |
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B.2. Termination Settings of LVCMOS Clock Output

Figure B-2 illustrates an industry-standard LVCMOS application circuit for quick reference. The LVCMOS output drives
capacitive load only (CL), and needs only one series termination resistor (Rs).

Rs is chosen based on the signal integrity requirement of the connection between the transmitter and the receiver.

Figure B-2. Recommended LVCMOS Termination Scheme for DC/AC Measurements

VDD VDD

Receiver

The desired output measurement can be done using an SMA cable connected to an oscilloscope. SMA offers an extra 50 Q
to the oscilloscope ground, which should be taken into account while doing measurements. This kit does not have any on-
board series termination or AC coupling options. Cypress recommends contacting Cypress Technical Support through
www.cypress.com/support or e-mail at clocks@cypress.com, if you want to evaluate any output with series termination or
with AC coupling.
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Figure B-3. Block Diagram
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Figure B-5. Controller Schematics
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Figure B-6. CY29430 Schematics
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B.4. Fabrication Drawing

Figure B-7. Fabrication Drawing
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B.5. Bill of Materials
Table B-1. Bill of Materials
. _ Manufacturing Part
Item Quantity Reference Value Description Manufacturer
Number
1 1 C6 0.01 UF SQ)F;’CER 10000PF 50V 10% X7R Murata Electronics GRM188R71H103KA01D
C7,C9,C11,C27,
C38,C41,C46,C
2 17 49,C53,C54,C5 0.1uF CAP CER 0.1UF 50V Y5V 0603 Yageo CCO0603ZRY5V9BB104
5,C56,C57,C65,
C66,C67,C68
3 1 C10 4. 7uF CAP CER 4.7UF 6.3V X5R 0603 Murata Electronics GRM188R60J475KE19D
Samsung Electro-
4 2 C12,C28 20nF CAP CER 0.02UF 50V X7R 0603 Mechanics America, CL10B203KB8NNNC
Inc.
5 1 C13 10pF CAP CER 10PF 50V COG 0603 TDK Corporation C1608C0G1H100C080AA
6 1 C26 2200pF CAP CER 2200PF 50V NP0 0603 Murata Electronics GRM1885C1H222JA01D
C8,C30,C34,C3
9,C40,C50,C51,
7 11 C52.C58,059.C 1UF CAP CER 1UF 25V 10% X5R 0603 | Taiyo Yuden TMK107BJ105KA-T
69
PTC
8 1 F1 RESETABLE PTC RESETTABLE .50A 15V 1812 | Bourns Inc. MF-MSMF050-2
FUSE
CONN HEADR BRKWAY .100 TE Connectivity AMP
9 1 52 VIN 02POS STR Connectors 9-146280-0-02
CONN HEADR BRKWAY .100 TE Connectivity AMP
10 1 ¥ VM 02POS STR Connectors 9-146280-0-02
11 1 J3 USB MINI B MINI USB RCPT R/A DIP TE Connectivity AMP | 17345101
Connectors
12 4 J7.38,J10,011 SMA CONN SMA JACK 50 OHM EDGE Clnch Connectivity 142-0701-801
MNT Solutions Johnson
J1,J13,J14,J15, CONN HEADR BRKWAY .100 TE Connectivity AMP
13 5 J16 JUMPER 03POS STR Connectors 9-146280-0-03
Visual
14 1 LED1 LED Green LED GREEN CLEAR 0805 SMD Communications CMD17-21VGC/TR8
Company - VCC
15 1 LED2 LED Amber LED AMBER CLEAR 0805 SMD Bivar Inc. SMO0805AC
FERRITE CHIP | FERRITE CHIP 600 OHM 1500MA .
16 1 L7 600 OHM 1.5A 1206 Murata Electronics BLM31PG601SN1L
17 2 R30,R31 499 RES SMD 49.9 OHM 0.1% 1/10W Panasonic Electronic ERA-3AEB49R9V
0603 Components
RES SMD 0.0 OHM JUMPER Panasonic Electronic
18 2 R7, R40 0 ohm 1/10W (0402pkg) Components ERJ-2GEOROOX
RES SMD 560 OHM 5% 1/10W Panasonic Electronic
19 2 R1,R211 560 0603 Components ERJ-3GEYJ561V
20 1 R3 100K RES SMD 100K OHM 5% 1/10W Panasonic Electronic ERJ-3GEYJ104V
0603 Components
21 1 R5 453 RES SMD 453 OHM 1% 1/10W Panasonic Electronic ERJ-3EKEA530V
0603 Components
22 1 R6 127 RES SMD 127 OHM 1% 1/10W Panasonic Electronic ERJ-3EKE1270V

0603

Components
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Manufacturing Part

Iltem Quantity Reference Value Description Manufacturer
Number
R16,R226, RES SMD 15K OHM 5% 1/10W Panasonic Electronic
23 3 R228 15K 0603 Components ERJ-3GEYJ153V
Panasonic Electronic
0, -
24 2 R17,R18 22 RES SMD 22 OHM 1% 1/10W 0603 Components ERJ-3EKF22R0V
o5 3 R20,R21,R227 30K RES SMD 30K OHM 5% 1/10W Panasonic Electronic ERJ-3GEYJ303V
0603 Components
0,
26 1 R201 10k gg(%SMD 10K OHM 1% 1/10W Yageo RCO0603FR-0710KL
0,
27 1 R202 22.6K §§O%SMD 22.6K OHM 1% 1/10W Yageo RCO0603FR-0722K6L
0,
28 1 R203 8.25K gg(%SMD 8.25K OHM 1% 1/10W Yageo RCO0603FR-078K25L
0,
29 1 R204 18k ggéSMD 18K OHM 1% 1/10W Yageo RCO603FR-0718KL
R4, R41, R206,
R213, R214, RES SMD 0.0 OHM JUMPER Panasonic Electronic
30 9 R223. R224, 0 ohm 1/10W Components ERJ-3GEYOROOV
R229, R231
31 2 R217,R218 1K RES SMD 1K OHM 1% 1/10W Panasonic Electronic ERJ-3EKE1001V
0603 Components
32 1 Ul CY29430FLQXI | Clock generator, QFN package Cypress CY29430FLQXI
CY8C5868LTI-
33 1 u7 LP039 QFNGS CY8C5868LTI-LP039 QFN68 Cypress CY8C5868LTI-LP039
34 1 us MIC5301 IC REG LDO ADJ 0.15A TSOT23-5 | Microchip Technology | MIC5301YD5-TR
PUSBM12VX4- TVS DIODE 5.5VWM 12VC .
35 1 uU10 TL115 6HXSON NXP Semiconductors PUSBM12VX4-TL,115
CRYSTAL 114.2850MHZ 18PF NX3225SA-114.285MHZ-
36 1 Y1l CRYSTAL4/SM SMD NDK EXS00A-CS06528
Special Jumper Installation Instructions
Install jumper HW, CONN, Rectangular, MINI Sullins Connector
37 1 J1 across pins 1 JUMPER, 6.5mm, CLOSE TYPE, Solutions STCO02SYAN
and 2 BLACK, NICKEL
Install jumper HW, CONN, Rectangular, MINI .
38 1 32 across pins 1 JUMPER, 6.5mm, CLOSE TYPE, gg:tgzr?””emr STCO2SYAN
and 2 BLACK, NICKEL
Install jumper HW, CONN, Rectangular, MINI Sullins Connector
39 1 J5 across pins 1 JUMPER, 6.5mm, CLOSE TYPE, Solutions STC02SYAN
and 2 BLACK, NICKEL
Install jumper HW, CONN, Rectangular, MINI Sullins Connector
40 1 J13 across pins 2 JUMPER, 6.5mm, CLOSE TYPE, Solutions STCO02SYAN
and 3 BLACK, NICKEL
Install jumper HW, CONN, Rectangular, MINI Sullins Connector
41 1 Ji4 across pins 1 JUMPER, 6.5mm, CLOSE TYPE, Solutions STCO02SYAN
and 2 BLACK, NICKEL
Install jumper HW, CONN, Rectangular, MINI .
42 1 J15 across pins 1 JUMPER, 6.5mm, CLOSE TYPE, ggméonneaor STCO2SYAN
and 2 BLACK, NICKEL
Install jumper HW, CONN, Rectangular, MINI Sullins Connector
43 1 J16 across pins 2 JUMPER, 6.5mm, CLOSE TYPE, Solutions STCO02SYAN
and 3 BLACK, NICKEL
Label
a4 1 N/A N/A LBL, PCA Label, Vendor Code, Cypress

Datecode, Serial Number 121-

Semiconductor
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Manufacturing Part

Iltem Quantity Reference Value Description Manufacturer
Number
60312-01 Rev 03
(YYWWVVXXXXX)
No Load Components
45 1 C5 10UF CAP TANT 10UF 16V 10% 1206 AVX Corporation TAJA106KO016R
46 2 C31,C35 33uF CAP TANT 33UF 6.3V 20% 1206 Rohm Semiconductor | TCA0J336M8R
a7 3 C62,C63,C70 1UF CAP CER 1UF 25V 10% X5R 0603 | Taiyo Yuden TMK107BJ105KA-T
48 1 C33 4.7uF CAP CER 4.7UF 6.3V X5R 0603 Murata Electronics GRM188R60J475KE19D
R14,R15,R210, . .
49 5 R223,R224,R23 0 ohm RES SMD 0.0 OHM JUMPER Panasonic Electronic ERJ-3GEYOROOV
0 1/10wW Components
50 P R216,R225 1K RES SMD 1K OHM 1% 1/10W Panasonic Electronic ERJ-3EKE1001V
0603 Components
0,
51 2 R221,R222 2.2K EGEOS?’SMD 2.2K OHM 5% 1/10W Yageo RC0603JR-072K2L
RES SMD 0.0 OHM JUMPER Panasonic Electronic
52 1 R42 0 ohm 1/10W (0402pkg) Components ERJ-2GEOROOX
53 1 R19 15K RES SMD 15K OHM 5% 1/10W Panasonic Electronic ERJ-3GEYJ153V
0603 Components
0,
54 1 R208 6.04K CF;GE(%SMD 6.04K OHM 1% 1/10W Yageo RC0603FR-076K04L
0,
55 1 R207 10k RES SMD 10K ORM 1% 1710W Yageo RCO603FR-0710KL
56 1 Ja 12C HEADER %%NN HEADER 5POS .100 VERT Molex, LLC 22-23-2051
FERRITE CHIP | FERRITE CHIP 600 OHM 1500MA .
57 1 L8 600 OHM 1.5A 1206 Murata Electronics BLM31PG601SN1L
58 1 H7 2 Pin Header TE_640456-2 (2-pin Header) TE Connectivity AMP | ¢ 16456.
Connectors
59 1 U9 MIC5301 IC REG LDO ADJ 0.15A TSOT23-5 | Microchip Technology | MIC5301YD5-TR
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CraHpapT
INeKTpPOoH
ﬂ CBAA3b

Mbl MOf04aA M aKTUBHO Pa3BMBAIOLLAACA KOMMAHWA B 061acTM  MOCTaBOK
3NEKTPOHHbIX KOMMOHEHTOB. Mbl NOCTAaBASEM  3/IEKTPOHHbIE  KOMMOHEHTbI
OTEYEeCTBEHHOIrO U MMMOPTHOIO NMPOWU3BOACTBA HAMPAMYIO OT NPOU3BOAMUTENEN U C
KpYMHEMLWKNX CKNaZ0B MUpa.

Enaro,a,apﬂ coTpygHn4ecTtesy C MMpPOBbIMU NOCTaBWMKaMWN Mbl OCYLLECTBIAEM
KOMMNNEKCHbIE N NN1aHOBblE MNMOCTABKU LumpoqaﬁLuero CNEeKTpa 3/1EKTPOHHbIX
KOMMOHEHTOB.

CobcTtBeHHan 3¢p@eKTUBHAA NOrMCTUKA M CKNag B obecneunBaeT HageKHYHo
MOCTaBKy MNPOAYKLMM B TOYHO YKa3aHHble CPOKM Mo Bcel Poccum.

Mbl ocyuiecTBisem TEXHUYECKYI0 MNOALEPKKY HAWWM  K/IMEHTaMm U
npeanpoaaxkHyto NPOBEPKY KayecTsa NpoayKumu. Ha Bce noctaBnsiemble NpoAyKTbl
Mbl MPEAOCTaBASEM TFAPaAHTUIO .

OcyuwiectBndem nNOCTaBKM NpoOAYKUMM nog, KoHTponem Bl MO PO Ha
npeanpuATUA BOEHHO-NPOMbIWIEHHOTO KoMnaekca Poccuun , a TakKe paboTtaem B
pamkax 275 ®3 c OTKpbITUEM OTAE/bHbIX CHETOB B YNONHOMOYEHHOM BaHKe. Cuctema
MeHeXMeHTa KayecTBa KomnaHum cooTBeTcTByeT TpeboBaHuam FOCT ISO 9001.

MWHUMaNbHbIE  CPOKM  MNOCTAaBKW, TMOKME  UeHbl, HeorpaHWYeHHbIN
aCCOPTUMEHT UM WHAMBMAYANbHbLIN MNOAXOA K KAMEHTaM ABAAIOTCA OCHOBOW ANA
BbICTPAMBaHMA A0FOCPOYHOIO M 3GPEKTUBHOIO COTPYAHMYECTBA C NPEeANPUATUAMM
PaANO3NEKTPOHHOMW NPOMBIWAEHHOCTU, NPEeanPUATUAMM BMNK u HayuHo-
nccnenoBaTeNbCKUMKU MHCTUTYTaMm Poccun.

C Hamu Bbl CTAaHOBMUTECH elle ycnewHee!

[HaLLIM KOHTAKTbI: \

TenedoH: +7 812 627 14 35

dNeKTpPOHHaA nouTa: sales@st-electron.ru

Appec: 198099, CaHkT-MNeTepbypr,
MpomblwneHHasa yn, gom Ne 19, nutepa H,
nometleHune 100-H Oduc 331
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